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Chapter 423

Tests for Two Groups
Assuming a Two-Part
Model
Introduction
This procedure provides sample size and power calculations for comparing two groups when the data come from
a two-part model. Two-part models assume that the data distribution is a mixture of a probability mass at zero and
a continuous distribution for data values greater than zero. Often, the continuous distribution is assumed to be
normal. The power formula is based on the work of Lachenbruch (2001).

Technical Details
Two-part models assume that the data distribution is a mixture of a probability mass at zero and a continuous
distribution for data values greater than zero. The density of a variable X from this model is written as
𝑓𝑓(𝑥𝑥) = 𝑝𝑝𝑖𝑖𝜃𝜃 [(1 − 𝑝𝑝𝑖𝑖 )ℎ𝑖𝑖 (𝑥𝑥)]1−𝜃𝜃

where p is the probability that X = 0 and hi(x) is a continuous density.

Test Statistic
The test statistic for the two part model is
2
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where U is a statistic that compares the non-zero parts of the model. It can be assumed to be a z, t, or Wilcoxon
test statistic computed on the non-zero data values.

Power Analysis
The power analysis is based on non-central chi-squared distribution. The non-centrality parameter of this
distribution is given by
𝜆𝜆 =

(𝑝𝑝1 − 𝑝𝑝2 )2 𝑛𝑛1 𝑛𝑛2
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where 𝛿𝛿 = 𝜇𝜇1 − 𝜇𝜇2 , the difference in the means of the continuous portion of the two groups.
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The power is the probability a two degree of freedom chi-squared random variable with non-centrality λ exceeds
the critical value computed from a central chi-squared distribution.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are Power, Sample Size, and Mean Difference. In most situations, you will likely select either Power or
Sample Size.
The ‘Solve For’ parameter will be displayed on the vertical axis of any plots that are generated.

Power and Alpha
Power
Power is the probability of rejecting the null hypothesis when it is false. Power is equal to 1 - Beta, so specifying
power implicitly specifies beta. Beta is the probability obtaining a false negative with the statistical test. That is, it
is the probability of accepting a false null hypothesis.
The valid range is 0 to 1. Different disciplines have different standards for setting power. The most common
choice is 0.90, but 0.80 is also popular.
You can enter a single value, such as 0.90, or a series of values, such as .70 .80 .90, or .70 to .90 by .1.
When a series of values is entered, PASS will generate a separate calculation result for each value of the series.
Alpha
Alpha is the probability of obtaining a false positive with the statistical test. That is, it is the probability of
rejecting a true null hypothesis. The null hypothesis is that the group proportions and means are equal.
Since Alpha is a probability, it is bounded by 0 and 1. Commonly, it is between 0.001 and 0.10.
Alpha is often set to 0.05 for two-sided tests such as this.
You can enter a single value, such as 0.05, or a series of values, such as .05 .10 .15, or .05 to .15 by .01.
When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

423-2
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Tests for Two Groups Assuming a Two-Part Model

Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N1, solve for N2
Select this option when you wish to fix N1 at some value (or values), and then solve only for N2. Please note
that for some values of N1, there may not be a value of N2 that is large enough to obtain the desired power.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.

N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1, solve for N2”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
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For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
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N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.
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Effect Size - Binomial Part (X = 0)
P1 (Prob X = 0 in Group 1)
Enter one or more values for the probability that a data value is zero in group 1. This value is compared with P2 in
the chi-squared test.
You can enter a single value such as 0.1 or a series of values such as 0.1 0.2 0.3 or 0.1 to 0.9 by 0.1.
The range is given by 0 ≤ P1 < 1.
P2 (Prob X = 0 in Group 2)
Enter one or more values for the probability that a data value is zero in group 2. This value is compared with P1 in
the chi-squared test.
You can enter a single value such as 0.1 or a series of values such as 0.1 0.2 0.3 or 0.1 to 0.9 by 0.1.
The range is given by 0 ≤ P2 < 1.

Effect Size – Normal Part (X>0)
δ (Mean Difference = μ1 - μ2|X > 0)
Enter one or more values for the difference between the group means at which the design is powered. Note that
this is the mean of the continuous part of the data. It does not include the binomial (0) part.
The permissible range of values is 0 ≤ δ. Note that δ² is used in the test statistic, so the sign does not matter.
You can enter a single value such as 4 or a series of values such as 1 2 3 or 1 to 10 by 1.
When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

Standard Deviation
σ (Standard Deviation of X|X > 0)
Enter one or more values for the standard deviation of the non-zero portion of the data. This is the standard
deviation used for both groups.
σ must be a positive number.
You can enter a single value, such as 5, or a series of values, such as 1 3 5 7 9, or 1 to 10 by 1.
When a series of values is entered, PASS will generate a separate calculation result for each value of the series.
Press the small 'σ' button to the right to obtain options for estimating the standard deviation.
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Example 1 – Finding the Sample Size
Researchers wish to compare the average medical expenditure by patients in two well-defined groups. Since
medical expenses are often zero, a two-part model is used. The researchers set δ to a range of values from 100 to
350. They set the standard deviation to the range 85 to 100 based on previous studies. They set P1 = P2 = 0.80.
They want to determine how many participants are needed to achieve 90% power at a significance level of 0.05.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Groups Assuming a Two-Part Model procedure window. You may then make
the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open
Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.90
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
P1 (Prob X = 0 in Group 1) ..................... 0.80
P2 (Prob X = 0 in Group 2) ..................... 0.80
δ (Mean Difference = μ1 - μ2|X > 0) ....... 100 to 350 by 50
σ (Standard Deviation of X|X > 0)........... 85 to 100 by 5

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results ────────────────────────────────────────────────────────────
H0: P1 - P2 = 0 and δ = μ1 - μ2 = 0
H1: P1 - P2 ≠ 0 and/or δ = μ1 - μ2 ≠ 0
Target
Actual
Power
Power
0.90
0.9019
0.90
0.9015
0.90
0.9021
0.90
0.9011
0.90
0.9027
0.90
0.9029
0.90
0.9014
0.90
0.9040
0.90
0.9019
0.90
0.9044
0.90
0.9047
0.90
0.9035
0.90
0.9075
0.90
0.9106
0.90
0.9115
0.90
0.9108
(Report Continues)

N1
92
103
115
127
41
46
51
57
23
26
29
32
15
17
19
21

N2
92
103
115
127
41
46
51
57
23
26
29
32
15
17
19
21

N
184
206
230
254
82
92
102
114
46
52
58
64
30
34
38
42

P1
0.80
0.80
0.80
0.80
0.80
0.80
0.80
0.80
0.80
0.80
0.80
0.80
0.80
0.80
0.80
0.80

P2
0.80
0.80
0.80
0.80
0.80
0.80
0.80
0.80
0.80
0.80
0.80
0.80
0.80
0.80
0.80
0.80

δ
100.0
100.0
100.0
100.0
150.0
150.0
150.0
150.0
200.0
200.0
200.0
200.0
250.0
250.0
250.0
250.0

σ
85.0
90.0
95.0
100.0
85.0
90.0
95.0
100.0
85.0
90.0
95.0
100.0
85.0
90.0
95.0
100.0

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050

References
Lachenbruch, P.A. 2001. 'Power and sample size requirements for two-part models'. Statistics in Medicine, Vol.
20, Pages 1235-1238.
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Report Definitions
Target Power is the desired power value entered in the procedure. Power is the probability of rejecting a
false null hypothesis.
Actual Power is the actual power achieved. Because N1 and N2 are discrete, this value is usually slightly
larger than the target power.
N1 is the sample size from group 1.
N2 is the sample size from group 2.
N is the total sample size from both groups. N = N1 + N2.
P1 is the probability that X = 0 in group 1.
P2 is the probability that X = 0 in group 2.
δ = μ1 - μ2 is the difference between group means at which power and sample size calculations are made.
σ is the assumed population standard deviation for each of the two groups.
Alpha is the probability of rejecting a true null hypothesis, H0.
Summary Statements ─────────────────────────────────────────────────────────
A test comparing two groups will use a two-part model which is a combination of a discrete
distribution and a continuous distribution. The discrete part is a 'probability mass' at zero.
The continuous part gives the distribution of values greater than zero. A chi-squared test with
2 degrees of freedom combines a test of the difference in proportions of 0's in the two groups
with a test of the difference in group means of the continuous part. Group sample sizes of 92
and 92 achieve 90% power to reject the null hypothesis of equality of both parts at a
significance level of 0.050. The proportion of 0's in group 1 is 0.80 and in group 2 is 0.80.
The difference in the means of the continuous part is 100.0. The standard deviation of the
continuous values is 85.0..

These reports show the values of each of the parameters, one scenario per row.

Plots Section

These plots show the relationship between the standard deviation and sample size for the two alpha levels.
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Example 2 – Validation using Lachenbruch (2001)
Lachenbruch (2001) gives an example of calculated values on page 1237 of his article. The sixth line of Table I
on this page gives the power when P1 = 0.1, P2 = 0.2, δ = 0.3, σ = 1, N1 = N2 = 100, and alpha = 0.05. He reports
a power of 0.702

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Groups Assuming a Two-Part Model procedure window. You may then make
the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open
Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 100
P1 (Prob X = 0 in Group 1) ..................... 0.1
P2 (Prob X = 0 in Group 2) ..................... 0.2
δ (Mean Difference = μ1 - μ2|X > 0) ....... 0.3
σ (Standard Deviation of X|X > 0)........... 1

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results ────────────────────────────────────────────────────────────
H0: P1 - P2 = 0 and δ = μ1 - μ2 = 0
H1: P1 - P2 ≠ 0 and/or δ = μ1 - μ2 ≠ 0
Power
0.7019

N1
100

N2
100

N
200

P1
0.10

P2
0.20

δ
0.3

σ
1.0

Alpha
0.050

You can see that PASS also calculates the power to be 0.702 (within rounding).

423-9
© NCSS, LLC. All Rights Reserved.

